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Overview  

However you decide to distribute information to the general public, it’s important that it’s 
appropriate and accessible to all audiences. The following guide lays out how to create 
accessible digital documents, presentations, and printed handouts.  
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Accessible Documents and Presentations Checklist  

This checklist includes basic considerations to help you create accessible documents. 

 

Language 

❏ Use plain language   

❏ Use person-first language  

❏ Provide contact information, include multiple ways to contact 

 

Document styling 

❏ Use bullets or lists to break up large blocks of text 

❏ Use sufficient color contrast between text, graphic, and background colors, with a 

minimum ratio of 4.5:1   

❏ Use accessible non-serif fonts like Verdana, Arial, Helvetica, Tahoma, or Roboto 

❏ For digital documents and websites, use a minimum font size of 12pt 

❏ For presentations, use a minimum font size of 24pt 

❏ For large print documents that will be printed, use a minimum font size of 18pt 

❏ Export PDFs for electronic distribution or accessibility (not print)  

 

Formatting 

❏ Use correct, properly tagged headings in sequential order (h1 through h6)  

❏ Begin large documents with tables of contents 

❏ Use alt text (image descriptions) for all images 

❏ Clearly label links to describe where they lead 

 

Hard copies 

❏ Have copies of your handouts available in regular print, large print, and Braille  

  

Presentations 

❏ Follow best practices for visual accessibility (e.g. text layout, contrast)  

❏ Make presentations available in accessible digital formats (e.g. alt text, proper headings) 

❏ Avoid flashing graphics or gifs 

  



Document Content 

When creating any document, handout or presentation, make sure you’re using the 

appropriate language. 

  

Plain Language 

Text written for the general public should use plain language, which is defined as writing that 

can be understood the first time it’s read or heard. 

 

Plain language is not “dumbed down” writing—it’s a way of writing that makes text easier for 

all readers to understand. Aim for an 8th-grade reading level or below, and ideally below a 5th-

grade reading level. Try to keep your sentences short and use simple words that most people 

are familiar with.  

 

Use Hemingway App to check your reading levels.  

 

Person-first Language 

When referring to people with disabilities, use what is called “person-first language.” Examples 

of this include: “person with a disability,” “people with disabilities,” “person with cerebral 

palsy,” or “person who uses a wheelchair.” 

 

Some words you should avoid altogether. These include: handicapped, retarded, lame, midget, 

crazy, crippled, physically challenged, differently-abled, suffering from, or other words with 

negative connotations.  

 

Learn more in the NYC Inclusive Terminology Guide, and the Conscious Style Guide.  

 

Contact Information 

When including contact information for a resource or organization, offer several ways to get in 

touch. These should include phone numbers, email addresses, and 711 relay. Website 

addresses are also helpful to include.  

 

  

http://hemingwayapp.com/
https://blueprint.cityofnewyork.us/wp-content/uploads/2018/05/Toolkit-Inclusive-Terminology-Guide.pdf
https://consciousstyleguide.com/


Creating Digital Documents 

Documents posted on a website for download should be readable both visually and by a screen 

reader. This means that, stylistically, content should be in a readable font and have high 

contrast. These elements will make documents readable for all readers, and especially those 

who have low vision. In addition, content should be formatted with headings and image 

descriptions so it can be fully interpreted by someone using a screen reader. 

 

Digital Document Formatting 

Please adhere to the following rules when designing a document.  

● Avoid using all caps 

● Contrast between background and text has to be a minimum of 4.5:1  

● Use accessible, non-serif fonts such as, Verdana, Arial, Helvetica, Trebuchet MS, Calibri 

or Tahoma. Avoid serif fonts like Times New Roman or Georgia  

● For digital documents and websites, use a minimum font size of 12pt  

● For presentations, like PowerPoints, use a minimum font size of 24pt 

● For large print documents that will be printed, use a minimum font size of 18pt  

 

Proper headings 

Headings (h1 through h6) can help you create content hierarchy for better readability, and are 

key to making information accessible to users with disabilities and low-literacy levels. 

 

Sighted users navigate web pages by skimming text, unconsciously using headings, links, and 

formatting to pick out the information needed. People who rely on screen readers also need to 

skim, which headings help with. But in order to make these functional for a screen reader, you 

need to properly format your headings. 

 

On pages with properly formatted headings, people using screen readers can skip to page titles, 

relevant sub-headings, or search results with just a few keystrokes.  

 

  



Below are descriptions of how to use different heading levels: 

● h1 headings: Main page topic. Try to only use one h1 per page. This heading typically 

appears at the top of the content area 

● h2 headings: Broad sections such as the beginning of the News or Results section 

● h3 headings: Article titles, program titles, search results, and other subsections 

● h4 – h6 headings should progress in consecutive order, as subsections of the previous 

heading 

  

Add a heading in Microsoft Word: 

1. Select the text and right click on it 

2. Go to the “Format” menu and choose “Style” 

3. Choose the appropriate level heading style such as “Heading 1,” Heading 2,” “Heading 

3,” etc. 

 

 

Table of contents 

Tables of contents and page numbers help all users navigate around a document more 

efficiently. Including a table of contents for documents longer than four pages makes it less 

overwhelming, since readers are able to understand the document’s scope without having to 

scroll through it. This is especially true for screen reader users, who can use tables of contents 

to quickly jump to later sections.  

 

(For documents with three pages or fewer, tables of contents make the document longer 

without adding helpful functionality.)  

 

Add a table of contents in Microsoft Word: 

1. Select the “References” tab in the ribbon menu and choose “Table of Contents” 

2. Choose a style from the formatting options 

3. Properly formatted headings will automatically populate in your table of contents   

(another reason it’s important to create properly formatted headings) 

4. Page numbers will be automatically generated within the table of contents, but not 

inserted onto the pages themselves. To create page numbers, select the “Insert” tab 

and select “Page Numbers.”  

 

  



Image Descriptions 

Any photo, logo, or graphic needs to have a text description so that users with visual disabilities 

can understand its relevance. Adding an image description is using alt text.  

 

Add alt text in Microsoft Word and PowerPoint:  

1. Right click on the image and select “Format picture” 

2. Navigate to the “Alt Text” pane  

3. Type the image description in the description field on the right side of the window  

 

When writing alt text, think about the reasons you’re including the image in the first place. Ask 

yourself the following questions:  

 

1. Who is in the photo?  

If there’s no one notable, use general characteristics like “marathon runners” or “happy 

people.”  

 

2. What are they doing? 

If they’re just standing or sitting around, describe their visible emotions, such as “smiling” 

or “looking focused.” 

 

3. Where and when is this taking place? 

This can be a general physical location like “outside,” or specific, like “at the NYC 

Marathon.” 

 

4. Why are you showing this photo at all? 

There’s a reason the photo is being shown — maybe it’s to show off how well attended an 

event was. If so, talk about the number of people in the photo.  

 

Graphs or data visualizations should have proper alt text. For simple ones, the alt text should 

include important trends and provide a summary of the data represented. For more complex 

ones, the data can be represented in an alternative table view or a downloadable report as an 

accessible PDF or Word document. A caption with a summary of the data can also be included 

for users with cognitive disabilities. 

 

  



Links 

Both sighted and blind users navigate by scanning through links. Make sure your hyperlink text 

always explains where your user is going. Avoid link labels like “Click here,” which don’t give any 

information to screen reader users skimming through links. Use underlining only for hyperlinks, 

not other text elements.  

 

• Do: Freeze your rent. 

• Don’t: Click here to freeze your rent. 

 

 

Exporting as PDF 

To create an accessible PDF from your document, it must follow the guidelines listed in this 

guide, including heading styles and alt text. When you save or export your document as a PDF, 

make sure to select the export option for electronic distribution and/or accessibility (not print). 

This will transfer the document styles to the PDF.  

  

http://nyc.gov/rentfreeze
http://nyc.gov/rentfreeze


Hard Copy Handouts 

Whether in the office or at an outreach event, there are ways to create accessible print 

documents for all audiences. For any hard copy documents that will be distributed, create three 

versions: 

● Regular print 

● Large print 

● Braille 

 

Regular Print 

● Avoid using all caps 

● Contrast between background and text must be a minimum of 4.5:1  

● Use accessible, non-serif fonts, such as, Verdana, Arial, Helvetica, Trebuchet MS, Calibri, 

or Tahoma. Avoid serif fonts like Times New Roman or Georgia 

 

Large Print 

● Avoid using all caps 

● Contrast between background and text must be a minimum of 4.5:1  

● Use accessible, non-serif fonts, such as, Verdana, Arial, Helvetica, Trebuchet MS, Calibri, 

or Tahoma. Avoid serif fonts like Times New Roman or Georgia 

● Font size: Minimum of 18pt 

 

Braille 

You should always create five to ten Braille copies of your handout in case someone requests 

one. The Mayor’s Office for People with Disabilities can help you make a few copies for free. 

You can also use one of the services listed in the Resources section of this guide. 

 

When you send a document to get embossed in Braille, make sure to: 

● Submit as a Word document 

● Remove any images in the document 

● Use headings, lists, and normal styles to organize the document 

 

 

 

 



Presentations 

Whether you’re out in the community or at a fellow agency, you should always make sure your 

presentations are accessible. These should be accessible both from a visual standpoint and a 

digital one, in case someone who is blind or has low vision requests the presentation in digital 

form.  

 

Text 

● Avoid using all caps 

● Use accessible, non-serif fonts, such as, Verdana, Arial, Helvetica, Trebuchet MS, Calibri, 

or Tahoma. Avoid serif fonts like Times New Roman or Georgia 

● Use a minimum font size of 24pt 

 

Layout and Colors 

● Avoid using large blocks of text 

● Contrast between background and text has to be a minimum of 4.5:1   

● Use bullets for lists 

● Use and edit standard slide styles, which have properly tagged headings 

● Give each slide a unique slide title 

 

Images and Tables 

● Include alt text for all images 

● Export any tables to a Word document as an alternative for screen reader users  

 

Language   

● Do not use: handicapped, retarded, lame, midget or crippled 

● Use: people with disabilities, people who are blind, people who have low vision, people 

who are deaf, people who are hard of hearing, people with physical disabilities, people 

with mental health disabilities, people with developmental disabilities instead 

● Write text at an eighth-grade reading level or below 

● Keep your text as simple as possible. If a word has a less complex alternative, use it 

 

Flashing 

● Avoid using graphics or transitions that flash because they might cause seizures  

https://support.office.com/en-us/article/Add-alternative-text-to-a-shape-picture-chart-table-SmartArt-graphic-or-other-object-44989b2a-903c-4d9a-b742-6a75b451c669


 

Contact Info 

● If sharing contact info in your slide deck, include phone numbers, email addresses and 

website addresses so that people can contact you regardless of their disability  

● Include 711 relay with any phone numbers: “For New York Relay users, please call 711” 

 

 

 

 

  



Resources 

Websites and Digital Documents 

• Web Content Accessibility Guidelines (WCAG) 2.0 

• Web Accessibility Initiatives Tutorials 

• PDF Techniques WCAG 2.0 

• WAVE Accessibility Checker 

• Web Accessibility In Mind (WebAIM) 

• WebAIM Color Contrast Checker 

• Paciello Group Color Contrast Analyzer 

• Tota11y Accessibility Visualization Toolkit 

• Adding Alternative Text in Office 365 

• Make PowerPoint Presentations Accessible 

• Make Word Documents Accessible 

• Make Google Docs Accessible 

• Make Google Slides Accessible 

• Make Keynote Presentations Accessible 

 

Braille Transcription Services 

All Global Solutions International: Makes Braille, large print, audio and electronic formats in 

English and 20+ languages including Arabic, Spanish and French. 

 

Website: http://allgsi.com/services/braille/ 

Phone: 1-800-896-7030 

E-mail: info@allgsi.com 

 

 

Baruch College’s Computer Center for Visually Impaired People (CCVIP): Offers quick and 

affordable service producing good quality literary Braille.  

 

Website: https://www.baruch.cuny.edu/ccvip/services_products.htm 

Contact: Judith Gerber 

Phone: 646-312-1425 

E-mail: Judith.gerber@baruch.cuny.edu 

 

 

https://www.w3.org/TR/WCAG20/
https://www.w3.org/WAI/tutorials/
https://www.w3.org/TR/WCAG-TECHS/pdf.html
http://www.wave.webaim.org/
http://www.webaim.org/
https://webaim.org/resources/contrastchecker/
https://developer.paciellogroup.com/resources/contrastanalyser/
http://khan.github.io/tota11y/
https://support.office.com/en-us/article/Add-alternative-text-to-a-shape-picture-chart-table-SmartArt-graphic-or-other-object-44989b2a-903c-4d9a-b742-6a75b451c669
https://support.office.com/en-us/article/make-your-powerpoint-presentations-accessible-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25
https://support.office.com/en-us/article/make-your-word-documents-accessible-d9bf3683-87ac-47ea-b91a-78dcacb3c66d
https://support.google.com/docs/answer/6199477?hl=en
https://accessibility.umn.edu/presentations/google-slides
http://archived-accessibility.umn.edu/keynote.html
http://allgsi.com/services/braille/
mailto:info@allgsi.com
https://www.baruch.cuny.edu/ccvip/services_products.htm
mailto:Judith.gerber@baruch.cuny.edu


Andrew Heiskell Braille and Talking Book Library: Get books in braille and audio, and find free 

events, workshops and classes. Every Saturday, there is a free computer clinic where individuals 

can learn about how to use a computer, browse the web, read and send emails, download 

books, and Word processing as a blind/low vision person. They also have a tactile graphics 

Braille embosser for creating Braille documents, and a 3D printer for creating 3D touch objects. 

Both are free to use. 

 

Website: http://www.nypl.org/about/locations/heiskell 

Phone: 212-206-5400 

Tech department: 212-621-0627 

 

 

 

http://www.nypl.org/about/locations/heiskell
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